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Introduction

Thank you for purchasing a Moxa V2416A panel computer running the Windows 7 Embedded operating system.
The Windows 7 Embedded OS provides a simple and familiar development environment for a variety of
industrial applications.
 Software Components
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Software Components
The following software components of the Windows Embedded Standard 7 OS come pre-installed on the
V2416A computer.

Windows Embedded Standard 7
Core OS:
• 32-bit or 64-bit (CTOS option) supported
• Remote Client
• Remote Procedure Call
Applications and Services Development:
• .Net Framework 4.5
• Remote Desktop Protocol 7.1
• COM OLE Application Support
• COM+ Application Support
• MSMQ
Internet Services:
• Internet Explorer 11
• IIS 7.0
File Systems and Data Storage:
• Windows Data Access Components
• Windows Backup and Restore
Diagnostics:
• Common Diagnostic Tools
• Problem Reports and Solutions
Fonts: Chinese (Trad. and Simp.), Japanese, Korean, Western, Middle Eastern, South East Asian, and South
Asian Fonts
Graphics and Multimedia:
• MPEG DTV-DVD Audio Decoder (MPEG-2, AAC)
• MPEG Layer-3 Audio Codecs (MP3)
• MPEG4 Decoders
• Windows Media Video VC-1 (WMV) Codecs
• DirectX and Windows Device Experience
• Windows Media Player 12
Management:
• Group Policy Management
• Windows Management Instrument (WMI)
• Windows Update
Networking:
• Extensible Authentication Protocol (EAP)
• Internet Authentication Service
• Telnet Server
• Bluetooth
• Domain Services
• Network Access Protection
• Network and Sharing Center
• Quality of Service
• Remote Access Service (RAS)
• Telephony API Client
• Windows Firewall
• Wireless Networking
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Security:
• Credential Roaming Service
• Credentials and Certificate Management
• Windows Authorization Manager (AZMAN)
• Windows Security Center
• Active Directory Rights Management
• Security Base
• Encrypted File System (EFS)
Embedded Features:
• Enhanced Write Filter (EWF)
• File-Based Write Filter (FBWF)
• Message Box Default Reply
• Registry Filter
• WSDAPI for .NET
Embedded Self-Health Diagnostic Software: SNMP-based remote scripting layer for monitoring, reporting,
and control

Linux
OS: Linux Debian 7
File System: EXT 4
Internet Protocol Suite: TCP, UDP, IPv4, SNMPv1/v2c/v3, ICMP, ARP, HTTP, SSH 1.0/2.0, SSL, DHCP, NTP,
NFS, Telnet, FTP, TFTP, PPP, PPPoE
Internet Security: OpenVPN, Netfilter/iptables
Web Server (Apache): Allows you to create and manage web sites; supports PHP and XML
Secure Shell for Remote Access: SSH allows remote logins to a secure encrypted console from any
connected network dial-up
Dial-up Networking: PPP Daemon for Linux that allows Unix machines to connect to the Internet through
dialup lines, using the Point-to-Point
Protocol (PPP). Works with ‘chat’, ‘dip’, and ‘dialup’, ‘dip’, and ‘diald’, among (many) others. Supports IP, TCP,
UDP, and (for Linux) IPX (Novell)
File Server: Enables remote clients to access files and other resources over the network
Watchdog: A watchdog timer that triggers a system reset upon software freezes, for both specific applications
and system-wide failures.
Application Development Software:
• Moxa API Library (Watchdog timer, Moxa serial I/O control, Moxa DI/DO API)
• GNU C/C++ compiler
• GNU C library
• Perl
Software Package:
• SNMP
• SafeGuard technology
Terminal Server (SSH): Provides secure encrypted communications between two un-trusted hosts over an
insecure network
Tailored MIB File for SNMP Control: SNMP allows centralized network monitoring and control. With Moxa’s
proprietary MIB file, trap notifications keep network overhead low while providing monitoring and control of key
BIOS settings; internal hardware sensors; interface connectivity for DI/DO, USB, and UART; and other
peripheral devices.
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System Initialization

In this chapter, we describe how to initialize the system settings on the V2416A embedded computer when
booting up for the first time.
The following topic is covered in this chapter:
 Overview
 Initializing User Settings
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Overview
Similar to using a laptop computer for the first time, you need to specify a user name and create a user account
to start using the V2416A embedded computer. Follow the procedure described in the next section.
NOTE

If you perform a system recovery on the V2416A embedded computer, the system automatically resets to the
factory defaults. You must initialize the user settings again.

Initializing User Settings
1. When you turn on the embedded computer for the first time, enter a user name for the computer.
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2. Type a password and retype the password to confirm.
You may also type a password hint that you can refer to if you forget your password. If you do not want to
set a password, leave all three fields blank. Click Next to continue.

3. Select a Windows update option.
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4. Select the computer’s current location.
Windows automatically applies the appropriate network settings based on the type of network you select.

5. When the Windows desktop screen appears, you can start using your V2416A embedded computer.
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Configuring the Serial Interface

This chapter describes how to configure the serial interface on the V2416A embedded computer.
The following topics are covered in this chapter:
 Overview
 Configuring the Serial Interface Mode
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Overview
The V2416A supports the following serial modes: RS-232, RS-485-2-wire and RS-422/485-4-wire. These
modes can be configured from COM1 to COM4.

Configuring the Serial Interface Mode
Complete the following steps to configure the serial interface mode:
1. Open Device Manager.
2. Under Multi-port serial adapters, right-click MOXA CP-114EL Series (PCI Express Bus) and select
Properties.

3. Click the Ports Configuration tab and select the COM port to configure (for example, COM1); then, click
Port Setting.
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4. From the Interface drop-down list, select a serial mode and click OK.

NOTE

By default, the serial mode setting applies to all ports on the V2416A computer. If you want to configure the
serial mode for a port, clear the Set the change to all port check box.

5. Check that the serial interface is correct.

3-3

4
4.

Enabling Embedded Filters

In this chapter, we describe how to enable the V2416A’s embedded filters.
The following topics are covered in this chapter:
 Enhanced Write Filter
 Overview
 Enabling Enhanced Write Filter
 Committing Data and/or Disabling EWF
 File-Based Write Filter
 Configuring File-Based Write Filter
 Excluding Files from FBWF Protection
 Managing Temporary Files Cached in the Overlay
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Enhanced Write Filter
Overview
Enhanced Write Filter (EWF) enables you to protect a volume from unauthorized writes by making the main
operating system (OS) drive a write-protected volume, effectively making the system a read-only system for
most users. This provides much stronger protection against malicious computer attacks (such as trojans,
worms, and viruses).
Enhanced Write Filter (EWF) allows Windows 7 users to protect data on their storage drive from permanent
changes of any sort, at the lowest level of hardware protection available: the bit level. EWF allows the OS to
boot from the hard disk, but protects the system by creating a virtual file system called an overlay. All writes
to an EWF-protected volume (the hard disk in the following figure) are only recorded on this virtual overlay
(the EWF Volume in the following figure), which is stored independently in random access memory (RAM).
Because EWF does not write data directly to the hard disk but instead only records system writes to this virtual
RAM overlay, any data that is “written” during system operation will disappear upon the next re-boot. This
approach allows the system to operate as if it is writeable when in reality all OS and user-space file systems are
stored in a permanent, read-only state.
If required, data written to the overlay can be committed to the protected volume, but this requires additional
setup and permissions that can only be granted by the administrator.
The following figure shows an overview of the EWF structure.

For more detailed information about EWF configuration and usage, refer to the following resources:
•

Visit Microsoft’s EWF Volume Configuration help pages.

•

See Microsoft’s EWF overview on the official Microsoft EWF help pages.

•

See Microsoft’s detailed description of EWF modes on the EWF help pages.

•

See Microsoft’s detailed description of the EWF API.

•

For EWF commands, refer to the MSDN web site:
http://msdn.microsoft.com/en-us/library/ms940853%28v=winembedded.5%29.aspx
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Enabling Enhanced Write Filter
Follow these steps to enable Enhanced Write Filter:
1. To open EWF, double-click the padlock icon in the system tray.
You may need to show hidden icons in the system tray.

2. In the Volume Information area, select the partition you want to enable write-protection on and click
Configure….
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3. The Configuration dialog box appears. Select Enable from the Pending command drop-down list and click
OK.

4. Reboot the system.
5. Log into the system and verify that the padlock icon in the system tray indicates that the drive volume is
locked with EWF.
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Committing Data and/or Disabling EWF
Perform the following steps to write (or commit) data to an EWF-enabled drive.
NOTE

You must have administrator privileges to commit data to the drive.

1. Double-click the padlocked drive in the system tray.
You may need to show hidden icons in the system tray.

2. In the Enhanced Write Filter: Overview dialog box, select the drive you want to configure and click
Configure.
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3. In the Enhanced Write Filter Configuration screen, select a drive volume; then, select an option from the
Pending Command drop-down list:
•
•

No Command
Disable: Disables EWF on the selected drive. The system automatically reboots if you select this
option.

•

Commit: Writes all current system changes to the hard drive.

•

Commit and Disable Live: Writes all current data and changes to the system, and also turns off EWF
on the selected drive (so that all future data and system changes will also be committed to the drive).
The system does not automatically reboot if you select this option.

NOTE

For detailed information, go to the Microsoft website at
http://msdn.microsoft.com/en-us/library/ff794092(v=winembedded.60).aspx.

File-Based Write Filter
This section describes how to use the File-Based Writer Filter (FBWF). Note that when Enhanced Writer Filter is
enabled, the File-Based Writer Filter function will not work.
According to Microsoft:
“File-Based Write Filter (FBWF) allows the Windows Embedded platform to maintain the appearance of read
and write access on write-sensitive or read-only storage. FBWF makes read and write access transparent to
applications.
Writing to storage media may be undesirable or impossible in embedded devices. FBWF redirects all writes
targeted for protected volumes to a RAM cache called an overlay. Used in this context, an overlay is similar to
a transparency overlay on an overhead projector. Any change made to the overlay affects the picture as seen
in the aggregate, but if the overlay is removed, the underlying picture remains unchanged.”
FBWF supports an advanced ESF feature, which allows users to specify which directory to write data to. The
default directory is c:\temp. The advanced feature allows you can read/write data to disk without committing
an action.
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Configuring File-Based Write Filter
Complete the following steps to enable the File-Based Write Filter (FBWF) feature. Although you can enable
FBWF and EWF on the same computer, FBWF does not protect a volume that is already protected by EWF.
Similarly, EWF does not protect a volume that is already protected by FBWF.
NOTE

Before using FBWF, make sure that you disable EWF.

1. Double-click the padlock icon in the system tray.
You may need to show hidden icons in the system tray.

NOTE

When disabled, the EWF and FBWF icons in the system tray look the same. To verify that you have opened the
correct writer filter program, check the screen title.

2. In the File Based Writer Filter: Overview screen, click Configure.
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3. To enable FBWF protection on a storage drive, perform the following actions:
a. Select Filter state enabled and Cache pre-allocation enabled.
b. In the Volume Configuration area, select the storage drive you want to protect and click Protect.
c. Click Apply or OK.

NOTE

To minimize memory usage on the overlay cache, select Cache compression enabled. However, cache
compression decreases performance when accessing protected volumes.
Select Cache pre-allocation enable to set the memory space available for the overlay cache when the
system starts up, instead of adjusting it as needed.
You cannot enable cache pre-allocation and cache compression at the same time.
The cache threshold field sets the amount of memory that can be used by the write filter for the overlay
cache. The default value and size limits for the overlay cache vary depending on the operating system.

4. Reboot the system.
5. Log into the system and verify that the padlock icon in the system tray displays a number and indicates that
FBWF is enabled on a drive. The following figure shows an example.
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Excluding Files from FBWF Protection
1. Double-click the FBWF icon in the system tray.
You may need to show hidden icons in the system tray.
2. In the File Based Write Filter: Overview window, click Configure.

3. Click the Exclusion List tab and configure the following fields:
•

Volume name – Select a drive volume from the drop-down list.

•

Add path – click the ellipsis (…) button to select a directory or file you want to exclude from FBWF
protection; then click the + button. The system displays the selected directory or file in the Path table.

4. Click the Cache Content tab and click Apply and OK

4-9

V2416A W7E Series

Enabling Embedded Filters

5. Reboot the system to make the changes take effect.

Managing Temporary Files Cached in the Overlay
1. On the Cached Content tab, you will see all the files currently cached in the RAM overlay. Three commands
are available:
•

Commit: Save a file from the cache to permanent storage, delete the file from the overlay, and
overwrite the original file.

•

Restore: Return the file to its original state, remove the file from the overlay cache and discard the
changes that added the file to the cache.

•

Add to exclusion list: Adds the file to the exclusion list after the next restart. This will delete the file
from the cached overlay and replace the current file in permanent storage with the modified cache file.
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2. The most common usage of the Cache Content filter will likely be to permanently write content to the hard
drive. To do this, select the file you wish to write to permanent memory and click on the commit button.
This will delete the file from the cached overlay and replace the current file in permanent storage with the
modified cache file.
Keep in mind that committing a configuration or application file will permanently alter the setup and/or
performance of the application or system.

For more details about FBWF configuration and usage, refer to the Microsoft help file that came with your
computer, or go to the following websites:
•

Microsoft’s FBWF Installation and Configuration help pages.

•

Microsoft’s FBWF overview on the official Microsoft FBWF help pages.

•

Microsoft’s detailed description of FBWF features on the FBWF help pages.

•

Microsoft’s detailed description of the FBWF API.
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Moxa Diagnostic Package

In this chapter, we describe the software package that can be used to monitor the system status of the V2416A
computer.
The following topics are covered in this chapter:
 Installing Moxa Diagnostic Utility
 Using Moxa Diagnostic Utility
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Installing Moxa Diagnostic Utility
To use Moxa Diagnostic Utility on the V2416A computer, first install the Moxa Diagnostic package.
Complete the following steps to install the Moxa Diagnostic package.
1. In the \utility\mxdiagnostic\ folder on the software DVD, double-click mxDiagnosticTool.msi.
2. A Welcome screen appears. Click Next.

3. Accept the default folder location or click Browse to select an installation folder; then, click Next.
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4. Click Next to continue.

5. Click Close to complete the installation process.
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Using Moxa Diagnostic Utility
This section describes how to use the Moxa Diagnostic Utility on the V2416A.
1. From the Start menu, click All Programs > Moxa > Moxa Predictive Maintenance Diagnostic Tool >
Moxa Predictive Maintenance Diagnostic Tool.

2. The System Temperature tab shows the current and threshold values of the CPU and system
temperatures (in degrees Celsius).
When the current temperature exceeds the threshold value, the screen displays “warning” in the Status
field and logs the status change.

3. To change the threshold value, double-click the value in the Threshold Value field and enter a number.

4. Click Yes to save the setting
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5. Click the System Voltage tab to view the current system voltages (in V).

NOTE

V_CPU = Voltage for processor core
VTT_CPU = Voltage for L3 shared cache, memory controller, and processor I/O power rail (Uncore)
VCCSA_CPU = Voltage for CPU System Agent
V1_0_5 = (VCCIO) = Voltage for processor uncore
V5_0 = Voltage for other chips

6. Click the System Frequency tab to view the current system frequency.

7. Click the System Resource tab to view the current resource usage.

8. Click the Settings tab to set the polling interval and log options.

NOTE

If the folder you specify in the Log Path field does not exist, the system automatically creates the folder when
new logs are recorded.
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9. To save the settings, click Apply.
10. Click Yes to confirm.
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Moxa SynMap Package

In this chapter, we describe the software package that can be used to easily control and monitor V2416A
computers.
The following topics are covered in this chapter:
 Moxa SynMap Package
 Overview
 Moxa SynMap OID List
 Installing CrystalDiskInfo
 Installing the Moxa SynMap Package
 Installing MXview
 Configuring MXview
 Loading the Moxa SynMap MIB File
 Loading the Host Resource MIB File
 Using Moxa SynMap OIDs
 Using HOST RESOURCE OIDs
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Moxa SynMap Package
Overview
SynMap is Moxa’s revolutionary software virtualization tool, which adapts SNMP into a fully portable remote
procedure interface. SynMap allows engineers to automate remote processes using SNMP object identifiers
(OIDs) rather than device-specific addresses, making a scripted SynMap procedure fully interoperable with any
other SynMap device. This means that a script created for one SynMap device may be directly copied to another,
immediately conferring the same functionality. This eliminates the need to rewrite and compile code for newly
configured devices, significantly reducing maintenance and deployment times.
SNMP is lightweight and easy-to-configure, and has long been popular with IT professionals. SNMP also enjoys
comprehensive native support in high-level languages, including .NET, Java, Python, and Ruby. For these
reasons, the SynMap framework has re-purposed SNMP into a universal configuration and control interface for
remote procedures, adapting it to not only monitor and control device internals like temperature, BIOS
parameters, and local interfaces, but also to report on and automate tasks at the process layer. Easily
integrated into any existing Network Management System (NMS), SynMap devices are a flexible and
cost-effective upgrade that returns obvious benefits to any IA network.
SynMap currently allows you to use SNMP for remote monitoring and control of a select set of computer
processes, but its list of features is rapidly growing. Using SynMap’s fully portable scripts, engineers will soon
be able to:
•

Access, monitor, control, and report on digital I/O at both the process and hardware layers.

•

Use OIDs to monitor, configure, and give process control over serial ports and other interfaces.

•

Monitor and control system attributes and process events via any NMS.

•

Build automated remote procedures using SynMap OIDs called by simple shell scripts, or a preferred
high-level language like Python, Perl, or VBScript—all without any need for low-level C APIs, or
platform-specific libraries.

•

Significantly simplify and reduce development times for custom utilities and automated executables.

•

Gain scripting and automation independence from OS-dependent libraries.

All of this may be achieved using the simple, reliable, and familiar SNMP, the easily accessible standard every
IT engineer knows. Discover how Moxa is expanding automation frontiers with the innovation we call SynMap.

Moxa SynMap OID List
For a complete listing of Moxa SynMap OIDs, refer to Appendix A: Moxa SynMap OID Table.
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Installing CrystalDiskInfo
Complete the following steps to install CrystalDiskInfo, a disk health diagnostics tool that allows you to monitor
the health of a disk.
1. On the software DVD, click CrystalDiskInfo6_1_9a-en.exe in the \utility\mxsynmap\ folder.
2. A Welcome screen appears. Click Next.

3. Select I accept the agreement and click Next.
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4. Accept the default destination folder or click Browse to select one; then, click Next.

5. Accept the default Start menu folder or click Browse to select one; then, click Next.

.
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6. Click Next.

7. Click Install.
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8. Click Finish.

9. Add a shortcut in the startup folder to execute the program when system boots up.

Installing the Moxa SynMap Package
Before you install the Moxa SynMap Package, disable the Windows SNMP server. Complete the following steps:
1. From the Start menu, right-click Computer and select Manage.
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2. In the Computer Management screen, select Services under Service and Applications.

3. In the Services pane, double-click SNMP Service.
4. In the SNMP Service Properties window, select Manual from the Startup type drop-down list and set the
Service status field to Stopped.

5. Click Apply and OK to disable the Windows SNMP service.
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To install the Moxa SynMap package, complete the following steps:
1. On the software DVD, double-click mxSynMap_setup in the \utility\mxSynMap\ folder.
2. A Welcome screen appears. Click Next.

3. Accept the default installation folder or click Browse to select one; then, click Next.
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4. Click Next to continue.

5. Click OK to continue.

6. When the installation process is complete, click Close.

7. When prompted, click Yes to restart the V2416A to use the SNMP functions.
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Installing MXview
This section describes how to use the MIB browser (mxView) to monitor or control Moxa SynMap OIDs. If you
already have your own MIB browser, skip this section.
Complete the following steps to install the MXview package:
1. On the software DVD, double-click MXView_Trial_V2.4.exe in the \utility\mxViewTrial folder.
2. In the Select Setup Language screen, select a language from the drop-down list and click OK.

3. Click Next.

4. Select I accept the agreement and click Next.
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5. Click Next.

6. Accept the default destination folder or click Browse to select one; then, click Next.

7. Click Next to continue.
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8. Click Next to continue.

9. Click Install.

10. Wait until the installation process is complete.
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11. Set the HTTP port to 81 and click Next.

12. Select Yes, restart the computer now and click Finish to reboot the system

13. After the computer is restarted, the MXview Service shortcut appears on the computer desktop.

Configuring MXview
1. Double-click the MXview shortcut on the desktop.
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2. Click Start.

3. Wait until the System Status field displays Running; then, clear the Connect to MXview with Built-in
Browser check box and click Launch Client.

4. MXview opens Internet Explorer. Follow the on-screen instruction to configure Internet Explorer settings.
Click Next to continue.
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5. Select No, don’t turn on and click Next.

6. Select Use express settings and click Finish to complete the configuration.
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7. Log in using the default username (admin). Leave the Password field blank. Then, click Login.

8. A dialog box appears prompting you to install Java Runtime Environment (JRE). Click OK.
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9. Click the title bar and select File Download Blocked > Download File.

10. Select Run to download and install Java Runtime Environment.
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11. Select Run to continue.

12. Click Install.
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13. Wait until Java installation is complete.

14. Click Close to complete the installation process.
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15. Click the message bar and select Enable Intranet Settings.

16. Click Yes to continue.
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17. Click Run.

18. Click Next to launch the setup wizard to configure basic settings; otherwise, click Cancel to launch the
program immediately.
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The MXview screen appears.

Loading the Moxa SynMap MIB File
Follow these steps to load the Moxa SynMap MIB file.
1. Double-click the MxView Service icon on the desktop.

2. Click Start.
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3. Wait until the System Status field changes to Running; then, click Launch Client to continue.

4. Click Cancel.
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5. Select MIB > MIB Browser.

6. In the MIB Browser window, select File > Load MIB.
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7. Go to c:\usr\share\snmp\mibs\ and select MOXA-SYS-MIB.txt; then, click Open.

8.

In the MIB Browser screen, verify that the MOXA-SYS-MIB folder displays in the File list.
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Loading the Host Resource MIB File
Complete the following steps to load the Host Resource MIB file.
1. Double-click the MxView Service shortcut on the desktop.

2. Click Start.

3. Wait until the System Status field becomes Running; then, click Launch Client to continue.
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4. Click Cancel.

5. Select MIB > MIB Browser.
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6. In the MIB Browser window, select File > Load MIB.

7. In the c:\usr\share\snmp\mibs\ folder, select HOST-RESOURCES-MIB.txt.
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In the MIB Browser screen, verify that the HOST-RESOURCES-MIB folder appears in the File list.

Using Moxa SynMap OIDs
Complete the following steps to use Moxa SynMap OIDs:
1. Check the UART type. Navigate to
MOXA-SYS-MIB\VALUES\moxa\embeddedComputer\moxaSystem\peripheralMgmt\ and
double-click uartConfigTable.
2. Click Get Subtree and check to make sure that your MxView settings are correct.
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Using HOST RESOURCE OIDs
Complete the following steps to use HOST RESOURCE OIDs.
1. Check disk usage. Navigate to HOST-RESOURCES-MIB\VALUES\host\hrStorage\hrStorageTable\
and double-click hrStorageEntry.
2. Click Get Subtree and verify that your MxView settings are correct.

3. Retrieve the value of hrStorageAllocationUnits.1 (for example, 4096).
4. Retrieve the value of hrStorageSize.1 (for example, 14384127).
5. Calculate the total disk size using the following formula:
total disk size = hrStorageAllocationUnits x hrStorageSize
In this example, the total disk size is 4096 x 14384127= 58917384192 = 54.9 GB
6. Check memory usage. Go to the HOST-RESOURCES-MIB\VALUES\host\hrStorage\ folder and
double-click hrMemorySize.
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7. Click Get.

8. You can also check the physical memory size using Windows Task Manager.

9. Check disk usage. Go to the HOST-RESOURCES-MIB\VALUES\host\hrDevice\hrProcessorTable\
folder and double-click hrProcessorEntry.
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10. Click Get Subtree.

11. You can also check the CPU loading of each CPU core using Windows Task Manager.
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Moxa Hot Swap Utility

This chapter shows you how to install the Moxa Hot Swap utility that you can use to monitor the system status
of a V2416A computer.
The following topics are covered in this chapter:
 Overview
 Installing the Moxa Hot Swap Utility
 Disabling MxHotswapService
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Overview
The V2416A features two SATA expansion slots that enable you to install 2.5-inch storage drives (HDD or SSD).
To enable the hot swap function, you must install the Moxa Hot Swap utility that enables you to safely remove
a storage drive from the V2416A.

Installing the Moxa Hot Swap Utility
1. On the software CD/DVD that comes with your V2416A, double-click MxHotswapInstaller_x86.msi in
the <software DVD>\utility\ mxHotswap\x86 folder.
2. The Setup Wizard screen appears. Click Next.

3. Accept the default destination folder or click Browse to select one; then, click Next.
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4. Click Next to continue.

5.

Click Continue.
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6. When the installation process is complete, click Close.

7. When prompted, click Yes to restart the V2416A.

After restarting the V2416A, the system automatically activates the hot swap function for the storage drives.

Disabling MxHotswapService
Before you install mxhotswap, you must first disable the MxHotswapService service.
1. From the Start menu, right-click Computer and select Manage.
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2. In the Computer Management screen, select Services under Service and Applications.
3. Double-click MxHotswapService.

4. A Properties dialog box appears. Select Manual from the Startup type drop-down list. This changes the
Services status to Stopped.
5. Click Apply to save the changes.
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Examples

This chapter provides examples to illustrate how to use the V2416A computer for a variety of applications.
The following topics are covered in this chapter:
 SerialInterface
 Digital Input/Output
 Watchdog
 Disabling Hot Swap Service
 Testing LEDs
 Testing Buttons
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Serial Interface
1. Copy the following files from the software CD/DVD to a folder on the V2416A.
•

mxsp.dll: \examples\V2416A_W7E_V1.0_example\lib\mxsp\x86\

•

sysinfo.dll: \examples\V2416A_W7E_V1.0_example\lib\mxsp\x86\

•

sysinfo.sys: \examples\V2416A_W7E_V1.0_example\lib\mxsp\x86\

•

mxGeneralIo.dll: \examples\V2416A_W7E_V1.0_example\lib\MxGeneralIo\x86\

•

SerialInterface.exe: \examples\V2416A_W7E_V1.0_example\Release\

2. Execute SerialInterface.exe.

3. Type 2 to set the serial interface. Follow the on-screen instructions.

4. Type 1 to display the current serial interface settings.

7-2

V2416A W7E Series

Examples

Digital Input/Output
1. Copy the following files from the software CD/DVD to a folder on the V2416A.
•

mxdgio.dll: \examples\V2416A_W7E_V1.0_example\lib\mxdgio\x86\

•

mxGeneralIo.dll: \examples\V2416A_W7E_V1.0_example\lib\MxGeneralIo\x86\

•

DIO.exe: \examples\V2416A_W7E_V1.0_example\Release\

2. Execute DIO.exe.

3. Type 4 to display the current DI and DO values.

4. Type 3 to set the DOUT port number. Follow the on-screen instructions.
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5. Type 4 to check if the port value was set correctly.

Watchdog
1. Copy the following files from the software CD/DVD to a folder on the V2416A.
•

mxdev.dll: \examples\V2416A_W7E_V1.0_example\lib\mxwdg\x86\

•

mxGeneralIo.dll: \examples\V2416A_W7E_V1.0_example\lib\MxGeneralIo\x86\

•

Watchdog.exe: \examples\V2416A_W7E_V1.0_example\Release\

2. To prevent the system from rebooting, press [Enter] at least once every 10 seconds; otherwise, the system
will reboot automatically.
3. To stop the watchdog, press q to exit the program
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Testing LEDs
NOTE

You must disable MxHotswapService before you can proceed in this section.
This section shows you how to use the test utility to display and set LED values.
1. Copy the following files from the product software DVD.
•

mxgpio.dll: \examples\V2416A_W7E_V1.0_example\lib\mxdgio\x86\

•

mxGeneralIo.dll: \examples\V2416A_W7E_V1.0_example\lib\mxgpio\x86\

•

LED.exe: \examples\V2416A_W7E_V1.0_example\Release\

2. Execute LED.exe.

3. Type 1 to display the current LED value.

7-5

V2416A W7E Series

Examples

4. Type 2 and follow the on-screen instruction to set the LED value.
When you set the LED value to 0, the LEDs turn off.
When you set the LED value to 1, the LEDs turn on.

Testing Buttons
This section shows you how to use the test utility to display and change button values.
1. Copy the following files from the product software DVD.
•

mxgpio.dll: \examples\V2416A_W7E_V1.0_example\lib\mxdgio\x86\

•

mxGeneralIo.dll: \examples\V2416A_W7E_V1.0_example\lib\mxgpio\x86\

•

Button.exe: \ examples\V2416A_W7E_V1.0_example\Release

2. Execute Button.exe. The program will start to poll the button status information.

7-6

V2416A W7E Series

Examples

3. To change the value of a button from 0 to 1, press the button.

NOTE

To exit from the button test program, press Ctrl + C.
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System Recovery

This chapter describes the system recovery process that you can perform if the system is not functioning
properly.
The following topics are covered in this chapter:
 Overview
 Setting Up the Recovery Environment
 Setting Up a Factory Default Recovery Image
 Step 1: Prepare the USB drive
 Step 2: Setting the BIOS to Boot via USB
 Step 3: How to Perform a System Recovery
 Step 4: Reset the BIOS to its Original State
 Creating a Custom System Image
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Overview
This section describes how to prepare your computer for recovery in the event the system becomes unstable.
You can perform a system recovery using one of the following system images:
•

A clean factory default image.

•

A user-generated image created from a fully configured, fully set up system.

Before you perform a system recovery, set up the system environment.

Setting Up the Recovery Environment
To set up the recovery environment on a V2416A computer, prepare a USB drive that has at least 4 GB of
memory and a copy of the recovery suite.
The following lists the major steps in the recovery procedure:
1. Copy the recovery programs and system image file on to the USB drive. Set up the drive as a live-drive
system with an ISO image of the boot environment.
2. Reboot the system and configure the BIOS to boot the recovery system from the USB port.
3. An image of the current software system will be created on the USB drive. The recovery environment will
use this image when restoring the system.
4. Reboot the system again and the BIOS is returned to its original state.

Setting Up a Factory Default Recovery Image
Step 1: Preparing the USB drive
1. Load the software DVD that came with your V2416A computer and execute tuxboot-windows-23.exe in
the \recovery\ folder.
2. Select Pre Downloaded and click the ellipsis (…) button to browse the file system and locate the boot
environment’s ISO image.
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3. Navigate to the \recovery\ folder on the software DVD and select the boot environment’s ISO image.

4. Select USB Drive from the Type drop-down list and select the drive letter that corresponds to the USB
drive from the Drive drop-down list. Click OK to copy the boot environment and bootloader to your USB
drive.

5. Click Exit.
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6. From the desktop, copy the directory containing the base OS from the software DVD on to the USB drive.
That is, copy #:\<SoftwareDVD>\recovery\os_image to the partition image directory,
F:\home\partimag\, on the USB drive.
However, if you want to recover from your own system image, back up a system image first. For more
information, refer to the Creating a Custom System Image section.
After Step 1 procedure is complete, proceed to the next section, Step 2: Setting the BIOS to Boot via USB.

Step 2: Set the BIOS to Boot via USB
This step shows you how to reset the BIOS so the system can boot directly from the USB port. You must
perform this action before you can continue to configure the system recovery environment.
1. Reboot the system, and, during the POST process, press F2 until you hear a long beep. Click SCU to enter
the BIOS setup menu.

2. Use the left and right arrow keys to navigate to the Boot menu.
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3. Use the up and down arrow keys to navigate to the Legacy link; then, press [Enter].

4. Use the up and down arrow keys to navigate to the Boot Type Order link; then, press [Enter].

5. Use the up and down arrow keys to navigate to the USB link; then, use the plus or minus (+/-) key to move
USB to the top of boot priority list.
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6. Press F10 and [Enter] to save and exit the BIOS configuration interface. This sets the system to reboot from
the hard drive.

Step 3: Performing a System Recovery
This step describes how to perform a system recovery. We include this as step 3 of the installation so
administrators can first perform a test run before deploying the system to the field.
To begin the system recovery process, configure the BIOS settings as described in the previous section Step
2: Setting the BIOS to Boot via USB. Then, connect the USB recovery drive to any USB ports on the V2416A
and then reboot the computer. If you have successfully prepared the USB and BIOS, the computer will boot into
the Clonezilla boot loader from the USB port.
1. Select clonezilla live restore disk to boot into the system recovery environment.

2. Wait until the boot process is finished.
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3. The screen displays warning messages to remind you that you are about to overwrite your entire operating
system with a new drive image, and ask you if you want to continue. When prompted, enter Y (case
insensitive) to start the system recovery process.
You can press any key or [Ctrl + C] to cancel the recovery process and exit Clonezilla.

4. The screen displays another warning message to remind you that you are about to overwrite your hard
drive and erase all data on the partition listed (sda1, in the following figure). If you want to continue, enter
Y (case insensitive).
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5. Wait until the process is finished.

6. To complete the recovery process, select (0) Power off to shut down the computer.
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7. After the computer is powered down, remove the USB drive and store it in a secure place.

Step 4: Resetting the BIOS
Reset the boot priority to the factory default settings to allow the system to boot from the main system storage
drive. This is done for two reasons:
•

The first reason is for security, since the computer will not be able to be rebooted from unauthorized USB
drives.

•

The second reason is because the computer is able to boot up from a non-bootable USB drive. Currently, if
the V2416A is set to boot from a USB drive, the V2416A’s boot process stops anytime you insert a
non-bootable USB data drive into the machine. The V2416A cannot detect USB data drives and
boot-capable OS drives.

Complete the following steps to reset the boot priority setting:
1. Reboot the system, and, during the POST process, press F2 until you hear a long beep. Click SCU to enter
the BIOS setup menu.

2. Use the left and right arrow keys to navigate to the Boot menu; then, press [Enter].
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3. Use the up and down arrows to navigate to the Legacy link; then, press [Enter].

4. Use the up and down arrow keys to navigate to the Boot Type Order link; then, press [Enter].

5. Use the up and down arrows to highlight Hard Disk Drive and use the plus or minus (+/-) key to move
Hard Disk Drive to the top of the boot priority list.
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6. Press F10 and [Enter] to save and exit the BIOS configuration interface. This sets the system to reboot, and
the system should now boot from the hard drive.
For more information about initializing user settings, refer to the System Initialization chapter.

Creating a Custom System Image
In this section, we describe how to create a custom system image so that all of your applications can be kept
and recovered. Using this procedure, you will save to the USB drive a copy of the entire system as it is
currently configured, and to be used as a full system recovery image if the system crashes. All files
under F:\home\partimag\ will be overwritten.
Before proceeding, make sure you have already completed Step 1: Prepare the USB drive and Step 2:
Setting the BIOS to Boot via USB, and then continue with the following steps to create a custom system
image.
1. Once the system has launched and the V2416A has booted the recovery environment from the USB drive,
navigate to clonezilla live save disk, and then select it by pressing Enter. This will take you into the
recovery image creation environment, allowing you to copy your full system setup to the USB drive.

2. The V2416A boots into the image creation environment. Wait until the boot process is complete.
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3. Once the image creation environment is booted up, a warning message displays asking whether you want
to continue. Note that if you create the recovery image, then any files copied in the /home/partimag
directory will be deleted. If you want to save the files in the USB partition image directory, you must
exit the recovery environment and copy the files to another disk. Press Y (case insensitive) to continue with
the image creation.
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4. The recovery environment starts to copy the entire hard drive to your USB drive. This may take several
minutes. Wait until the process is complete.

WARNING
Do NOT remove the USB drive from the computer during the data copy process.

5. Choose whether to power down the computer (press 0), reboot (press 1), access the console terminal (to
access a console TTY, press 2), or re-initiate the entire procedure (press 3).

WARNING
Do NOT remove the USB drive from the computer until you have rebooted or powered down the system.
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6. Power down the system and remove the USB drive.
The recovery environment setup is complete and you have created an OS image in the USB
Folder\home\partimag\os_image folder. Label the USB drive and store it in a safe place.
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Moxa SynMap OID Table

This appendix provides information on the Moxa SynMap OID table.
The following topics are covered in this appendix:
 Moxa SynMap OID Table
 HOST RESOURCE OID Table
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Moxa SynMap OID Table
The following table shows the full list of Moxa SynMap OIDs.
Item Name

OID

MAX-Access

Description

Support

productName

1.3.6.1.4.1.8691.17.1.1.1.0

read-only

Show the product name



productDesc

1.3.6.1.4.1.8691.17.1.1.2.0

read-only

Show the product short
description

productVersion

1.3.6.1.4.1.8691.17.1.1.3.0

read-only

Show the product



version
productBuildDate

1.3.6.1.4.1.8691.17.1.1.4.0

read-only

Show the product’s last



build date; the format is
YYMMDDHH
biosVersion

1.3.6.1.4.1.8691.17.1.4.1

read-only

Show the BIOS version

biosSaveSetting

1.3.6.1.4.1.8691.17.1.4.2

read-write

Write: 1 saves the bios
setting
Read: 0 means the
setting has been applied

biosSettingStatus

1.3.6.1.4.1.8691.17.1.4.3

read-only

Show a comparison of
“bios CMOS setting” and
“bios new setting”

bootDeviceStatus

1.3.6.1.4.1.8691.17.1.4.4.1

read-only

firstBootDevice

1.3.6.1.4.1.8691.17.1.4.4.2

read-write

Show the currently
active boot devices
Read: Show the current
first boot device
Write: Set the boot
device

pwrOnAfterPwrFail

1.3.6.1.4.1.8691.17.1.4.8.1

read-write

Set the computer to
power on after a power
failure

pwrLanWakeUp

1.3.6.1.4.1.8691.17.1.4.8.3

read-write

Enable/Disable wake on

read-only

Reference index for each 

LAN functionality
tempSensorsIndex
tempSensorsDevice

1.3.6.1.4.1.8691.17.1.
5.1.1.1.1

observed device

1.3.6.1.4.1.8691.17.1.5.1.1. read-only

The name of the

1.2

temperature sensor



being read
tempSensorsValue
voltSensorsIndex
voltSensorsDevice
voltSensorsValue

1.3.6.1.4.1.8691.17.1.5.1.1. read-only

The temperature of this

1.3

sensor in mC

1.3.6.1.4.1.8691.17.1.5.1.2. read-only

Reference index for each 

1.1

observed device

1.3.6.1.4.1.8691.17.1.5.1.2. read-only

The name of the device

1.2

we are reading.

1.3.6.1.4.1.8691.17.1.5.1.2. read-only

The voltage in mV



1.3.6.1.4.1.8691.17.1.6.1.2. read-only

Number of digital input



1.0

pins in the current





1.3
ioDiNumber

system
diIndex
diPort
diValue

1.3.6.1.4.1.8691.17.1.6.1.2. read-only

Reference index of each

2.1.1

digital input pin

1.3.6.1.4.1.8691.17.1.6.1.2. read-only

Port number of the

2.1.2

digital input pin

1.3.6.1.4.1.8691.17.1.6.1.2. read-only

Digital input status:

2.1.3

0 is low, 1 is high
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Item Name

OID

MAX-Access

Description

diTrapEnable

1.3.6.1.4.1.8691.17.1.6.1.1. read-write

Agent will send a trap

2.1.4

message when the

Support

digital input pin status
has changed and this
object is enabled
ioDoNumber

1.3.6.1.4.1.8691.17.1.6.1.2. read-only

Number of digital output 

3.0

pins in the current

1.3.6.1.4.1.8691.17.1.6.1.1. read-only

Reference index of each

4.1.1

digital output pin

1.3.6.1.4.1.8691.17.1.6.1.2. read-only

Port number of the

4.1.2

digital output pin

1.3.6.1.4.1.8691.17.1.6.1.2. read-write

Digital output status:

4.1.3

0 is low, 1 is high

system
doIndex
doPort
doValue
uartNumber

1.3.6.1.4.1.8691.17.1.6.3.1

read-only

Number of internal






UARTs in the current
system
uartIndex
uartType

1.3.6.1.4.1.8691.17.1.6.3.2. read-only

Reference index of each

1.1

UART port

1.3.6.1.4.1.8691.17.1.6.3.2. read-write

UART mode:

1.2

0 is RS232,




1 is RS485 2-wire,
2 is RS422,
3 is RS485 4-wire
usbNumber

1.3.6.1.4.1.8691.17.1.6.3.1. read-only

Number of ports,

0

regardless of their
current state, in the usb
general port table

usbDeviceIndex

1.3.6.1.4.1.8691.17.1.6.4.1. read-only

The index is identical to

3.1.1

usbPortIndex for the
corresponding USB port

usbDeviceVendorID

1.3.6.1.4.1.8691.17.1.6.4.1. read-only

The USB device port

3.1.2

vendor HEX-formatted
string, as it is provided
to the USB host by the
USB device

usbDeviceProductID 1.3.6.1.4.1.8691.17.1.6.4.1. read-only
3.1.3

The product ID
HEX-formatted string as
it is provided to the USB
host by the USB device

usbDeviceActiveClas 1.3.6.1.4.1.8691.17.1.6.4.1. read-only

Returns the USB Device

s

3.1.4

usbPlugTrapEnable

1.3.6.1.4.1.8691.17.1.6.4.1. read-write

Agent will send a trap

4

message when a USB

Class type of the active
configuration

device is inserted or
removed, and this object
is enabled
moxaSystemTrapIP

1.3.6.1.4.1.8691.17.1.9.1.0

read-write

Set Trap IP address



moxaSystemTrapCo 1.3.6.1.4.1.8691.17.1.9.2.0

read-write

Trap community



mmunity
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HOST RESOURCE OID Table
The following table shows Host Resource OIDs.
Item Name

OID

MAX-Access

Description

Support

hrProcessorTable

1.3.6.1.2.1.25.3.3

read-only

Show CPU usage



hrStorageTable

1.3.6.1.2.1.25.2.3

read-only

Show disk and memory



usage
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